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If you miss any information in this help chapter or have any suggestions for additions, please feel free to 

contact us via e-mail: documentation@copadata.com (mailto:documentation@copadata.com). 

 

 

If you have concrete questions relating to your project, please feel free to contact the support team via 

e-mail: support@copadata.com (mailto:support@copadata.com) 

 

 

If you realize that you need additional licenses or modules, please feel free to contact the sales team via 

e-mail: sales@copadata.com (mailto:sales@copadata.com) 

 

mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com
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To be able to use zenon as an editor and/or Runtime, the product must be licensed. zenon runs in Demo 

Mode (on page 4) until it has been licensed.  

To license zenon: 

1. In the editor, navigate to File -> General configuration -> License product...  

2. the dialog for entering license data opens  

3. Enter the data for soft licensing or dongle licensing  

You find the data for this: 

 on your license certificate 

 On the license sticker 

 in the license fileLicense.txt  

Path in Vista: C:\Users\Public\Documents\zenon_Projects\  

Path in XP: C:\Dokumente und Einstellungen/All Users/Anwendungsdaten/COPA- 

DATA/zenon651 

 pay attention to capital letters and small letters when entering the data! 

4. close the editor 

5. After the editor is restarted, use zenon with the license entered 

 

Serial Number License serial number. 
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Activation number: License activation number. 

OK Import data and start zenon  with this license when it is next 

started. 

Cancel Discard entries and use zenon with the previous license or no 

license. 

Request soft license Opens the dialog to request a soft license. 

Help Opens online help. 

License Runtime 

To license only one Runtime: 

1. In the operating system, navigate to Start -> All programs COPA-DATA -> Licensing 651  

2. The licensing assistant opens  

3. Enter your serial number and license number, or request a soft license (on page 9) 
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If the editor is not licensed, it runs in demo mode. Runtime runs in demo mode if it is not licensed. 

Demo mode For the first 40 times the editor is started, it runs for 30 

minutes, indicating that it is running in demo mode. The time is 

reduced to 10 minutes from the 41st time the program is 

started. 

Runtime demo mode An unlicensed Runtime runs for 30 days. 
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You can see which license you are currently using and which modules are included in this when starting 

zenon  in the start screen or after clicking on Info on... in the Help menu:  

 

Editor version Editor version number. 

Serial Number License serial number. 

Activation number: License activation number. 

Expiration time (optional) Information on the expiration date of the license for limited 

licenses. 

Field with modules: Information on licensed module. 

In menu Help the entry Info about  opens a dialog box which offers information about the zenon 

version and the licensing. 
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The licenses for the Editor and the Runtime are calculated by adding up the necessary TAGs or IOs. 

1 TAG equals 1 variable. For determining the license size, consider the total number of TAGs (= 

variables) of the following drivers: 

 PLC drivers and bus drivers 

Variables of the following drivers do not count: 

 internal driver 

 system driver 

 mathematics driver 

 simulation driver 

You can license TAGs for the Editor and the Runtime in the following gradation: 

 64 TAGs 

 128 TAGs 

 256 TAGs 

 512 TAGs 

 1,024 TAGs 

 2,048 TAGs 

 4,096 TAGs 

 8,192 TAGs 

 16,384 TAGs 

 65536 TAGs 

 unlimited 

A license upgrade to a higher number of TAGs is possible at any time. 
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License can also be based on I/Os. For determining the license size, consider the total number of IOs of 

the following drivers: 

 PLC drivers and bus drivers 

Variables of the following drivers do not count: 

 internal driver 

 system driver 

 mathematics driver 

 simulation driver 

1 bit:   1 I/Os  

1 byte    8 I/Os  

1 WORD 16 I/Os  

1 DWORD 16 I/Os  

1 float  16 I/Os  

1 string (max. 64 characters) 16 I/Os  

If you cannot find the desired data type in the list, it is because of the selected driver. Some drivers have 

a specific denotation of the data types. You will find more information in the driver documentation of 

the driver you use. You will find the driver documentation either in the onlie help in the section 

Drivers or as a PDF file on our CD/DVD or on our website www.copadata.com 

(http://www.copadata.com) for download. 

  Example 

96 binary and 20 numerical values are to be visualized in zenon: 

Multiply the 20 numeric values with 16 and you receive 320 I/Os. Add these to the 96 

binary values. As a result you get 416 I/Os, which now are the basis for the license size. 

http://www.copadata.com/
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In the status line of the detail view of the variables the following information can be found: 

 

 How many I/Os are used currently. 

 How many I/Os are licensed. 

 An example: 

 3799/550/1: 3799 entries exist, 550 are listed because of a filter, one entry is selected. 

 For project 22730 an unlimited number of I/Os is licensed. 
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You can license zenon in different ways: 

 Soft licensing (on page 9): Requests a unique PC identification number when the editor or 

Runtime is started. 

Characteristics: 

 The license cannot be stolen. 

 The license is computer specific. 

 Practical for notebooks. 

 Dongle licensing (on page 10): Looks for a hardware dongle at a parallel port or USB port when 

the editor or Runtime is started.  

Dongles are available as: 

 Workplace dongle: 

 Network dongle: A certain number of licenses are booked on a central dongle on the 

network, which can be used at the same time as concurrent-use licenses.  

Dongle characteristics: 

 Easy to use 

 A license can be taken from one PC to another by simply moving the dongle. 

 No problems due to hard disk failures 

  Info 

If there is no license or all licenses are are assigned in the network, then the editor or 

Runtime starts in demo mode (on page 4). 

 

The soft license assigns a computer with a unique identification. In doing so, certain components of the 

computer are examined. This license always only works on a certain computer. If it is to be transferred 
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to another computer or too many components on the licensed computer are changed, it must be 

reissued.  

To obtain a software license: 

1. In the File menu, select: General configuration> License product  

2. The licensing dialog opens 

3. Click on Request soft license 

4. Enter the product serial number 

5. Click on License request for soft licensing 

6. Enter your contact details  

7. There are two possibilities for sending these: 

a) automatic 

 Select the the desired COPA-DATA organization with the Send to button   

 When clicking on OK, the license request is sent by your email program 

a) manually 

 Click on the Finish button  

 The license request is saved as a text file; an information window informs you of the name 

and save location 

 send the email by email or fax to your sales partner 

As soon as you have received your license data, reopen the licensing dialog and enter your activation 

number. 

 

 

With dongle licensing, a dongle is connected directly to the computer for an individual workspace 

license or to a network computer for a network license. zenon uses two dongle systems: 

 Wibu key (on page 11) 

 CodeMeter (on page 14) 

Both systems are automatically included in the installation of zenon. Users who already work with a 

Wibu key will continue to receive licenses for their Wibu key dongles.  



11 
 
 

 

In general, no further settings need to be made for dongles used locally. The use of network dongles 

may mean that individual configuration is necessary. You can find these in the respective dongle 

software. For details of this, see the chapters on the Wibu key (on page 11) and CodeMeter (on page 

14). 

 

6.2.1 Wibu key 

A Wibu key can be used at a single workplace or in a network. The dongle must be active in a USB port 

or parallel port on the local computer or as a server on a network computer.  

To check the settings of the stick: 

1. Open system control 

2. Open Wibu key  

3. Select the stick to be tested on the local computer or on the network 

To list server Wibu boxes in the network, click on the Read in button 

4. Check if the number in the last column of the second row is identical with the starting number of 

the stick 

 

You can read more about the operation of the stick in the network dongle (on page 12) chapter. 
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Network dongle 

To use a Wibu key in the network as a dongle, the server and client must be configured accordingly: 

 Server configuration (on page 12) 

 Client configuration (on page 13)  

  Attention 

The Wibu key uses port 22347. This port is fixed and cannot be changed. Note: 

 If a firewall other than that integrated into the Windows operating system is 

used, this port must be enabled if you wish to use the Wibu key as a 

network dongle.  

 

 

Configuring the server 

The Wibu-Key server has to run on the dongle server. The Wibu-Key server can be configured either as 

an application (e.g. started via Autostart) or as a service. 

On installing the Wibu-Key software the options 

32 Bit WkNet/WkLAN network server 

Install as NT service with Autostart 

have to be activated, so that the Wibu-Key server is installed as a service (recommended). 
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In order to start the Wibu-Key server as an application, a link to the file WkSvW32.exe has to be 

created in the Windows Autostart. 

The file can be found in the directory C:\Programs\WIBU-KEY\Server\. 

 

Configuring a client 

Some network settings for the client have to be entered in the Control Panel. Under Wibu key 

subsystems, you can select the type of network access you use. We use WkLan. 

Under Server Name/IP address either the server name or its IP address or a mask for the IP address is 

entered. With Browse the list is filled with all found dongle servers. 

 

The entries are processed in the sequence of the list and also can be combined. 

If the first entry is a certain server, it is checked, if the dongle server service runs on that PC and if a 

dongle is plugged in (faster!). If no dongle is found here and the next entry is a filter mask, all PCs in the 

network going with that filter mask are are tried out. 
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On the Contents page, the server(s) where the dongles were found should then be listed: 

 

 

6.2.2 CodeMeter 

CodeMeter can be used at a single workplace or in a network. The CodeMeter USB stick must be active 

in a USB port on the local computer or as a server on a network computer. The dongle firmware must be 

at least version 1.16 or above.  

  Attention 

If the dongle is removed during operation, the editor closes. The editor then opens in demo 

mode until a valid license is recognized.  

To configure, start the CodeMeter control center administration application via: Windows 

Desktop -> Start -> All programs -> CodeMeter -> CodeMeter Control Center.   

The CodeMeter control centre opens with 3 tabs: 

License: contains information on the dongles found. 

Events: Displays the number of sticks connected, the license entries, the firm items found and all 

access to the CodeMeter Runtime server. To log the entries on a permanent basis, activate the logging 

entry in the file menu. 

Allocation: Configures the allocation of licenses. 
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License Lists all active CodeMeter sticks 

Name Individual name of the stick selected; can be assigned with the 

button on the right. 

Serial no._ Serial number of the stick selected. 

Version Firmware version of the selected stick. 

Status Status of the selected CodeMeter stick. 

deactivated The stick connected is deactivated and cannot be used by any 

application. 

Activates when connected The Stick is activated so long as it is connected; it is 

automatically deactivated after it is removed from the PC. 

Activated The stick is fully activated and remains activated after it is 

removed. 

Recommended status: Ensures that unauthorized persons do not 

have access to licenses and personal data (such as 

CmPasswordManager) if the stick is lost. 

  

License updating Starts the assistant to add, amend and delete licenses. 



16 
 
 

 

Eject Allows the stick to be ejected. 

Change password Enables the password to be changed. 

CodeMeter has been started/stopped Information on whether the CodeMeter service is running. Can 

be changed in the Action menu. 

WebAdmin Starts the web browser with the administration user interface 

for network dongles Port 22350 must be open for this, for 

details, see the chapter on network administration (on page 17).  

 

 

Update certified time 

You can update the certified time saved in the dongle via the CodeMeter time server. To do this, you 

need an active Internet connection. 

To update the time: 

1. Start the CodeMeter WebAdmin 

2. Check your network settings (on page 23): 

a) Are the proxy settings correct in CodeMeter Webadmin?  

b) Is your access data up-to-date? 

3. Go to the Contents -> CmStick menu 

4. Click on the Update button.  

5. You are notified that all sticks have been updated with this. 

6. Click on OK.  
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7. You receive information on the update carried out. In the event of an error message (on page 

27), you primarily check your access data.  

 

 

 

Network administration 

For network administration, start the WebAdmin user interface by clicking on the WebAdmin button in 

the CodeMeter control center. Detailed information on the individual settings can be found in the 

CodeMeter WebAdmin help pages. You get to this via the Help button in WebAdmin. The most 

important options and instructions are also in this document: 

 CodeMeter stick administration (on page 18)  

 License administration (on page 19)  

 Saving license data (on page 19) 

 Network settings (on page 23) 

 Proxy settings (on page 23) 

  Attention 

CodeMeter WebAdmin uses port 22350. Note: 

 If a firewall other than that integrated into the Windows operating system is 
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used, this port must be enabled.  

 If the port is changed, the WebAdmin surface cannot be started, because the 

port is part of the address, for example: 

http://localhost:22350/Content.html?BoxSerial=2-1355435  

In this case, use appropriate freeware tools or standard Windows tools to 

determine which port is currently being used and enter this address into the 

address line of the browsers instead of 22350. Then change the port back to 

22350 in WebAdmin. 

 

 

CodeMeter sticks 

WebAdmin starts in Contents/CmStick view. 

Here, you select the desired dongle in a drop-down list and can see its data and status as configured in 

the control center (on page 14).  

 

CmStick Drop-down list of recognized sticks. 

Name  Shows the name given in the control center (on page 14). 

Hardware Hardware version of the stick. 
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First drive Drive information for the stick, drive sizes are only given for 

sticks with flash memory. 

Status Activation status as defined in the control center (on page 14). 

Certified time (on page 16) The certified time saved on the stick. is updated using the 

update button. 

 to update using the CodeMeter Timeserver, you require 

an active internet connection. Ensure that the network settings 

(on page 23) are correct, in particular in relation to current 

access data. 

Box time Internal time saved on the stick.  

System time Local time on the CodeMeter Runtime server. 

Free memory Free memory available on the stick. To defragment the memory, 

click on the Defragment button. 

 

 

Licenses 

You administer your licenses in the Licenses tab in the Contents menu. 

 Select the desired dongle from the drop-down list.  
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 You can find information on the licenses of these dongles below the Ing. Punzenberger 

COPA-DATA GmbH subheading.  

 

Product Code Numerical value for the product. Clicking on the number leads 

to the details. 

Name Ing. Punzenberger COPA-DATA GmbH 

Usage units If applicable, display of usage units remaining. 

Expiration date If applicable, the expiration date is shown. zenon switches to 

demo mode (on page 4) after this point in time.  

Activation date If applicable, the activation date is shown. zenon switches to 

demo mode (on page 4) after this point in time.  

Number of licenses Total number of licenses 
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 Click on the number in the Product Code column for details.  

 

Dongle number Must correspond with the number of the active dongle. 

A dongle can also have a time limit:  

 Expiration date  

 Time period for use 

The dongle is equipped with an expiration date.  
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In the Licenses tab in the Contents menu, the expiration date is given in the expiration date 

column with the date and time in UTC format.  

 

The dongle is equipped with a specified usage period. This starts from the first time that zenon Editor or 

Runtime is used. To check the time limit: 

 Navigate to the Licenses tab in the Contents menu  

 Click in the entry under Ing. Punzenberger COPA-DATA GmbH on the digit in the 

Product Code column 

 The Product Item Details window opens  
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 You can see the licensed period and the start date in UTC format in the Usage period line. 

 

 

Network and Proxy 

For faultless communication with a Network dongle and the start of WebAdmin, correct network 

settings are a requirement. 
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Network address Select an IP address to which the CodeMeter Runtime server 

should connect.  

Standard: All.  

The connection is made to the first CodeMeter Runtime server 

found.  

The choice of a defined address is primarily necessary if the 

computer is functioning as a network license server and has 

several  

network cards.  

Network port Port for CodeMeter communication in the network.  

Standard: 22350  

The value can be adjusted individually. In this case, it must be 

ensured that all CodeMeter Runtime servers use the same port.  

 do not change port. 

UDP response time Maximum response time within which a UDP request must be 

answered.  

Standard: 1000 milliseconds. 

Start as server Active: The computer becomes a CodeMeter network server 

and makes all its licenses available in the network. 

Server search list Here, specific CodeMeter network servers can be defined by 

entering computer names or IP addresses. Then only the servers 

defined in the list are searched for. This way, requests from 

clients are directed to a defined CodeMeter Network server. 

 If a CodeMeter Server is in a different 

subnetwork, use the IP address for the search list.  

This search list should only be used if the CM stick 

cannot be found in the network. 
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For access to CodeMeter services in the internet, such as time server, enter the applicable access data for 

your company here. 

 

 

  Attention 

CodeMeter notes this access data. If you regularly change your access password, you must 

also change this in the CodeMeter WebAdmin proxy settings! 
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Request or update license 

To request or update licenses for CodeMeter, select the the Update license button in the 

Licenses tab in the CodeMeter control center (on page 14). The license update assistant starts: 

 

Decide if you are: 

 requesting a license  

 entering a license update 

 wish to create a receipt for COPA-DATA 

 

With license requests, you can: 
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 extend an existing COPA-DATA license 

 create a new COPA-DATA license 

 

 To add another COPA-DATA license: 

 Select Ing. Punzenberger COPA-DATA GmbH 

 To create a new COPA-DATA license: 

 enter the CodeMeter FirmCode that you received from COPA-DATA.  

 Select a save location for your license request. 

 Select the file with the license update 
 

Troubleshooting 

zenon only runs in demo mode Check  

 your licenses 

 The connection to the network dongle 

 if the license information was correctly entered in zenon6.ini. 

Also look for possible spaces after the serial number (serial5=) 

or the activation keys (activationkey5=). 

Path to zenon6.ini: 
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Vista: C:\ProgramData\COPA-DATA\System 

XP: C:\Documents and Settings\All Users\Application 

Data\COPA-DATA\System 

Dongle is not found 
 Check the network settings (on page 23).  

 If the stick is in another domain, add it to the server list (on 

page 23). 

 Increase the UDP response time (on page 23). 

Certified time cannot be updated Check: 

 Proxy settings (on page 23), especially access data and 

Password  

 List of time server under Settings -> time server 

 for example: cmtime.codemeter.com, cmtime.codemeter.de, 

cmtime.codemeter.fr, cmtime.codemeter.us 
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The licensing tool can be controlled with the following flags as parameters: 

Passing over a parameter is done by putting a `/` or a `-` before the parameter:  

e.g.: /silent or -silent 

request forces the program to omit the first dialog and go straight to the dialog for requesting the 

activation key 

(it does not matter if the flag /silent or -silent is also used) 

sernum:<num> forces the program to use the serial number which is passed with <num>  for 

licensing instead of reading the number from the zenon6.ini file. 

actkey:<key> forces the program to use the activation key which is passed with <key>  for 

licensing instead of reading the key from the zenOn6.ini file. 

silent forces the program to not show a dialog. The file License.txt is still created. 

mailto:<addr> works only in connection with the flag silent  and forces the program to send the license 

request to the specified address <addr>  via e-mail. 
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Licensing of modules in the server client operation has the following characteristics: 

The following cases are distinguished: 

 Server and client licensed: Archives can be opened and edited at the client 

 Server licensed and client not licensed: Archives can be opened but not edited at the client 

 Client not licensed and started as standalone: Archive window can be opened; the individual 

archives cannot be opened 

The following cases are distinguished: 

 Server licensed and client not licensed: ALC functionality is available unrestrictedly 

 Client not licensed and started as standalone: ALC functionality is not available 

  Info 

If the Server is licensed for the Energy Edition, ALC is also licensed. 

The following cases are distinguished: 

 Server licensed and client not licensed: EMS functionality is available unrestrictedly 

 Client not licensed and started as standalone: EMS functionality is not available 
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